Technical Note 179

Wireshark for Modbus RTU
Installation, setup and capture instructions

Introduction

Since its introduction in 1979, Modbus RTU became an industry standard for communication in control applications. It
has been a standard in ABB drives for decades. As such, there is a significant installed base of applications using
Modbus. When issues arise which require an understanding of what Modbus registers and services are being accessed,
troubleshooting can stall without this information. This paper describes how to configure a common network analysis
tool — Wireshark — to capture Modbus RTU traffic over RS-485, providing necessary information regarding Modbus
communication in an application.

What is Wireshark?

Wireshark is a network packet analyzer. Historically, such an analysis tool was either expensive or proprietary.
Wireshark, however, is available for free as an open-source project maintained by its users. It is widely considered to be
one of the best packet analyzers available today.

Although best known as a capture and analysis tool for Ethernet-based protocols, it has evolved to also accept input
from a computer’s serial COM ports. As well, user-demand has driven Wireshark developers to add Modbus RTU
protocol decoders to this open-source project, as it already supported Modbus/TCP over IP.

Network Example

Below is a simple network that will be used in this technical note. It features two ACH580s configured for Modbus RTU
connected to a Modbus client (ModScan) hosted on a laptop. These are using COM6. COMT is used separately to
connect Wireshark to the Modbus RTU network and capture the traffic:

Modbus RTU (EFB) Modbus RTU (EFB)
MACID=1 MACID=2

= -

Wireshark &=% )
—>COM7 Ll COM6 +——
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Wireshark installation
e The latest Wireshark application is available at the following link: https://www.wireshark.org/
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e Launch the downloaded setup file to install Wireshark. The default installation options can typically be used,
unless the user has a specific reason to select others.

Modbus RTU capture extension for Wireshark

e  With Wireshark installed, there is an additional capture extension for Modbus RTU that must be installed. This
extension can be found at the following link:

GitHub - jzhvymetal/WiresharkSerialAdapter: Wireshark Serial Adapter for Windows
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https://www.wireshark.org/
https://github.com/jzhvymetal/WiresharkSerialAdapter

O Product Solutions Resources Open Source Enterprise Pricing

Navigate to the latest version and download WireSharkSerialAdapter.exe:

Search or ju Signiin

B jzhvymetal / WiresharkSerialAdapter Pubiic L) Notifications % Fork (2 T Star 2

<> Code

© lssues I Pullrequests ® Actions [ Projects @ Security |~ Insights

[D Files WiresharkSerialAdapter / VSCODE_v6 / (2
F main - W jzhvymetal Add fles via upload &3 Scsfb01-3manthsago ) History
Q Gotofile
Name Last commit message Last commit date
> VSCODE_V1
> VSCODE_V2
» VSCODE_v3 vscode Add files via upload 3 months ago
> I VSCODE vé O WireSharkSerialAdapter.cpp Add files via upload 10 months aga
O WireSharkSerialAdapter.exe Add files via upload 3 months ago
> vscode O baud.ini Add files via upload 10 months ago

[) WireSharkSerialAdapter.cpp

[ WireSharkSerialAdapter.exe

[ baud

ini

() 00A_Wireshark Serial Adapter RS

[ 00_Wireshark Serial Adapter RS4

[ 01_Wireshark Serial Adapter Cop

[ 02_Wireshark Serial Adapter-Usin.

WiresharkSerialAdapter / VSCODE_v6 /[WireSharkSeriaIAdapter.exel ©

B4 jzhvymetal Add files via upload @B

\. Code |

5¢5f01 - 3 months ago @ History

Download raw file
Raw [_lT—' L 7 -

b

Blame 3.15 MB

With this file downloaded, navigate to the Wireshark application folder and locate the following subfolder:

System (C:) > Program Files > Wireshark > extcap > wireshark

If it doesn’t exist, create it. Copy WireSharkSerialAdapter.exe to this folder.

Note that this isn’t an executable to be explicitly launched by the user. Wireshark will execute it as an
additional capture option.

USB-t0-485 communication adapter

This technical note is written assuming a USB-to-485 communication adapter has already been installed and

setup on the user’s computer. If assistance is needed in getting this setup, please refer to ABB Technical Note
76:

https://search.abb.com/library/Download.aspx?DocumentID=LVD-EOTKNQ76U-

EN&LanguageCode=en&DocumentPartld=&Action=Launch

LVD-EOTKN179U-EN REV A

Effective: 2024-09-30



https://search.abb.com/library/Download.aspx?DocumentID=LVD-EOTKN076U-EN&LanguageCode=en&DocumentPartId=&Action=Launch
https://search.abb.com/library/Download.aspx?DocumentID=LVD-EOTKN076U-EN&LanguageCode=en&DocumentPartId=&Action=Launch

Wireshark COM port setup

looks like:

Launch the Wireshark application. The initial start-up screen will list the available capture ports. This list will
be different for each user’s computer, depending on its configuration. Below is an example of what this screen

r
‘ The Wireshark Network Analyzer
Fila Edit

- O P
ture  Analyze Statistics Telephony Wireless Tools Help

[I |App|y a display filter ... <Ctrl-/>

=]

il
(]

® Q @ F [

Welcome to Wireshark
Capture

..using this filter: [ | Enter a capture filter ...

= | 2 interfaces shown, 11 hidden™
@ BACnet MS/TP on COM®&

Serial Port Adapter (WireSharkSerialAdapter.exe)

Learn

User's - Wiki - Questions and
Guide

Mailing Lists -
Answers

SharkFest - Wireshark Discord - Donate

You are running Wireshark 4.4.0 (v4.4.0-0-g009%a163470b5). You receive automatic updates.

L e Ready to load or capture

|| No Packets

| | Profile: Default
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e Inthis list, Serial Port Adapter (WireSharkSerialAdapter.exe) should be an option. Click on the settings icon @
to the left to bring up the setup options:

[ ‘ ‘;a';';resl_'iar_k - Interface Options: Serial Port Adapter (WireSharkSerialAdapter.exe) X

_ Default
Port Com7 v G
Baud Rate 19200 v &
Byte Size 8 v G
Parity EVEN v | G
Stop Bits 1 v G
Interframe Timing Detection Event v G
Interframe Timebase Multipler :1X Modbus Character v || G
Interframe Multipler 30 C
Interframe Delay(us) 0.0 C
Interframe Correction Modbus CRC v G

| Wireshark DLT 147 User DLT v || &

: Save parameter(s) on capture start

Restore Defaults Start Save Discard Help

e Launch Windows Device Manager to confirm the COM port assigned to the connected USB-485 adapter

e  Select this COM port and set the baud rate, byte size, parity and stop bits of the Modbus RTU channel to be
monitored.

e  Use the Interframe settings shown in the screenshot above.
e  Select User DLT 147 as the Wireshark DLT.
e Save these settings.
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e  Returning to the main screen, select Preferences from the Edit pull-down menu and navigate to Protocols:

M Wireshark - Preferences - O X
v~ Appearance Prot Is
Columns
Font and Colors O Display hidden protocol items
Layout O Display byte fields with a space character between bytes
Capture 0 ) )
Expert Look for incomplete dissectors
Filter Buttons (L] Enable stricter conversation tracking heuristics
Name Resolution ]
s [Protocols O Ignore duplicate frames
RSA Keys Deinterlacing conversations key NOMNE -
> Statistics - - -
The max number of hashes to keep in memory for determining duplicates frames 10000
Advanced
I
OK Cancel Apply Help
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e  Expand Protocols and select DLT_User. Click on Edit to add an entry to the Encapsulation Tables. Click the “+”
button to add a DLT:

M Wireshark - Preferences — a X

DB-LSP-DISC
DCCP
DCERPC Encapsulations Table Edit...
DCOM
DCT2000 M User DUTs Table _ 9 x
DDTP
DECT-MITEL-

| DeviceMet

| DHCP/BOOTI
DHCPFO
DHCPv6
DHCPv6 Bulk
Diameter
DICOM
DIs
DISCARD
DISTCC
DJIUAV
DLEP

| DLM3
DLSw

DLT /

DLT_USER

DMP /

DMX Channe

DNP 2.0 B LYl b E';. C\Users\USIEBRU\AppData\Roaming\Wireshark\user dlts

DLT User

DLT Payload dissector Header size Header dissector Trailer size Trailer dissector

OK Copy from Cancel Help

T T T LTRSS T TR TS
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. Select User O (DLT = 147) and manually edit the Payload dissector to be mbrtu:

M User DUTs Table — O X
DLT Payload dissector Headersize Header dissector Trailer size  Trailer dig
User 0 (DLT=147) mbrtu ] ]
+ = m A v B CAUsers\USJEBRUNAppData\Roaming\ Wireshark\user dlits
oK Copy from Cancel Help

e  Click OK and return to the main screen.

LVD-EOTKN179U-EN REV A
Effective: 2024-09-30



Wireshark capture

e  With the COM port properly configured, a traffic capture is initiated by double-clicking the selected COM port.
The content of the capture will depend on the connected devices. The following is an example of the active
window panes:

AN &6 TRE QesEFE ] E 668iH
._II';' rilary THRe e :"_-I-
Hao, Time: Source Destination Protocol Lengtt info
T 17443759 Modbus RTU B Query: Unit: 1, Func: : Read Holding Registers
72 17.699282 Moedbus RTU 17 Response; Unit: 1, Func: 3: Read Holding Registers
7318001259 Modbus RTU B Query: Unit: 1, Func: ¥: Read Holding Registers
74 18.1844%]1 Modbus RTU 13 Response: Unit: 1, Func: 3: Read Holding Registers
7518, 445534 Modbus RTU & Query: Unit: 1, Func: ¥: Read Molding Registers
76 18699481 Modbus RTU 17 Response: Unit: 1, Func: : Read Holding Registers
TT 18992287 Modbus RTU B Quary: Unit: 1, Func: : Read Holding Registers
T8 19.173526 Modbus RTU 13 Response: Unit: 1, Func: ¥: Read Molding Registers
19 194358765 Modbus BT 8 Quary: Umit: 1, Func: 3: Rpad Molding Registers
B0 19 . GETET Modbus RTU 1¥ Response: Unit: 1, Func: : Read Holding Registers
Bl 19.995759 Modbus RTU ] Query: Umit: 1, Func:  3: Read Holding Registers
B2 28.173875 Modbus BTU 11 Responss: Unit: 1, Func: 3: Road Molding Registers
B3 28,4423688 Medbus RTU ] Query: Unit: 1, Func:  3: Read Holding Registers
B4 38.718511 Modbus RTU 17 Response: Umit: 1, Fung: 3: Rpad Holding Registers
85 2@,995462 Medbus BTU B Query: Unit: 1, Func: 3: Read Holding Registers
B& 31.153563 Modbus RTU 13 Respense: Umit: 1, Func:  3: Read Holding Registers
B7 21416400 Moedbus RTU B Quary: Unit: 1, Func: : Read Holding Registers
B8 21.683229 Medbus RTU 17 Respense: Unit: 1, Func:  3: Read Holding Registers
B9 22.0a4529 Modbus RTU B Query: Unit: 1, Func: 3: Read Holding Registers
'-IFra- 442 17 bytes on wire t]iﬁ bits), 17 bytes captured (1356 @1 83 &c 1a <3 09 0D 80 083 0D 90 90 59 0d 48 da
DLT: 147, Paylosd: sbrtu (Modbus RTU) - a5
» Hodbus RTU
w Hodbus
[~ 000 BEll = Function Lode: Read Holding Registers (3)
[Fequest Frame; 43]
[Time frem request: ©,.248228000 seconds)
Byte Count: 12
» Register 105 (UINT16): 6867
* Register 186 {UINT16): @
» Register 107 {(UINT16): 3
» Register 108 (UINT16): &
» Register 189 {UINT16): 89
» Register 110 (UINT1&): 3408

O 7 Serial Por Adapter (WireShancSenalAdapter.exel <lve CAPIEE in progiesss Packets: 80 Profile: Delautt

e  The main pane is an overall summary of the Modbus RTU traffic, with a brief description of each message type.
When a frame is selected in this pane, the lower-left pane contains a breakdown of the packet content by field-
type, and the lower-right packet is the packet content in hexadecimal format.

e The selected frame number is displayed in the packet details frame on the lower left, as well as the contents of
the Modbus message. In this example, the results of the Modbus Read Holding Request for 6 registers is
shown.

e  The Wireshark capture is stopped by clicking on the red square, second from the left.
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Wireshark capture save

e Finally, the contents of the Wireshark capture can be saved to a file for later review. This is found under the
File->Save pulldown:

‘ Wireshark - Save Capture File As X
Savejn | Documents v| o Er
i Name - Status Date modified
ACH550 @ 12/15/2022 11:55 AM
Quick access ACHS580 (@) 12/15/2022 11:54 AM
l ACS320 @ 12/1/2022 1:39 PM
ACS400 &) 8/19/2021 6:57 AM
Desktop BACnet = 5/13/2022 12:58 PM
Eclipse (&) 12/1/2022 12:53 PM
m E-Clipse Screens @) 3/28/2022 3:59 PM
Libraries Expenses [ 11/14/2022 7:06 PM
[a FENA-11 Testing (&) 1/18/2021 2:21 PM
= LON @ 9/13/2022 10:56 AM
This PC ModScan (&) 1/20/2021 9:24 AM
. RAE = 12/21/2022 2:36 PM
@ Silkroad @ 1/20/2022 11:38 AM
Network Spiceroad [ 9/23/2022 242 PM
Spider @ 6/14/2022 318 PM
Tools (&) 12/27/2022 10:38 AM
< >
File name: Test_Capture \/| | Save
Save as type: Wireshark/. - pcapng (" ntar gz" ntar zst™ ntar lz4:". Cancel
Help
[“]Compress with gzip

e Enter afilename and save to a known location. The file extension is .pcapng. This file can be shared for
additional review.

Wireshark capture review

To review a previous Wireshark capture, simply double-click on the .pcapng file and Wireshark will automatically open,
proceeding immediately to the capture window shown previously. From here, additional review and filtering can be
done to analyze network issues.

Wireshark capture file filtering

Due to typically large capture files, one of the more useful filtering options is to sort specifically for the device that is
reported to have issues. Thus, only those transactions for the device of interest can be isolated and saved to a separate
file. This makes capture files much more manageable.

e Select any frame in the upper pane and expand the details in the lower left pane by clicking on the caret next to
the Modbus RTU portion of the packet.
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e The field of interest for this example is Unit ID. Select it in the lower left pane by clicking on it, and right-mouse
click to display the filtering options. From these, select Apply as Filter->Selected:

‘ *Serial Port Adapter (WireSharkSerialAdapter.exe) — (m] X

| File Edit View Go Capture Analyze Statistics Telephony Wireless Tools Help
Al @ CFRE | &= ? 8 =5Ela a| FEH

I
[I |Apmy a display filter ... <Ctrl-/> Expand Subtrees v] +
. - Collapse Subtrees
No. Time Source Destination 2
19 4.715421 Exgandiall 3: Read Holding Registers
20 4.731459 Collapse All 3: Read Holding Registers
21 5.882732 . 3: Read Holding Registers
22 5.019023 grpiviasieliany it :  3: Read Holding Registers
23 5.722504 Apply as Filter » Apply as Filter: mbrtu.unit_id ==
24 5.738853 N
Prepare as Filter 4
25 6.010181 Selected
Conversation Filter 4
26 6.026162 Not Slected =
27 6.713132 Colorize with Filter 4
..and Selected
28 6.729712 Follow » - J
29 7.001237 =2 SE S
30 7.017204 1/O Graph 4 ..and not Selected
31 7.721287 Copy » ...or not Selected
32 7.736825 ITRESO HOTOINE REgISTErS
33 7.993283 Show Packet Bytes... Ctrl+5hift+0 3: Read Holding Registers
34 8.0088868 Export Packet Bytes... Ctrl+Shift+X 3: Read Holding Registers
35 8.727995 : 3: Read Holding Registers
36 8.743874 Wiki Protocal Page 3: Read Holding Registers
37 5.815383 Filter Field Reference 3: Read Holding Registers
38 9.031635 Protocol Preferences » 3: Read Holding Reegisters
> Frame 29: 8 bytes on wire (64 bits), 8 bytes captw Decode As... Ctrl+Shift+U I1
DLT: 147, Payload: mbrtu (Modbus RTU) Go to Linked Packet
~ [oderRRi Show Linked Packet in New Window
[unit 1D: 2
CRC-16: ©x15e7 [unverified]
[CRC-16 Status: Unverified]
> Modbus
|
I
@ 7 unit ID (mbrtu.unit_id), 1 byte || Packets: 68 - Dropped: 0 (0.0%) | Profile: Defautt
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This will populate the display filter field with the filter syntax to select Modbus device #2. Only transactions for
this device will be displayed:

‘ #Serial Port Adapter (WireSharkSerialAdapter.exe)

— O X
| File Edit View Go Capture Analyze Statistics Telephony Wireless Tools Help
AR i@ TEAREG Qe EF S =eaeFEH
[ | mbrtu.unit_id == [BED -]+
No. T Source Destination Protocol Lengtt Info
92 Modbus RTU 8 Query: Unit 2, Func: 3: Read Holding Registers
10 2.029721 Modbus RTU 17 Response: Unit 2, Func: 3: Read Holding Registers
13 3.804769 Modbus RTU 8 Query: Unit 2, Func: 3: Read Holding Registers
14 3.828795 Modbus RTU 17 Response: Unit 2, Func: 3: Read Holding Registers
17 3.996230 Modbus RTU 8 Query: Unit 2, Func: 3: Read Holding Registers
18 4.811337 RTU 17 Response: Unit 2, Func: 3: Read Holding Registers
21 5.002732 R 2, Func: 3: Read Holding Registers
22 5.919%023 Modbus RTU 17 Response: T 2, Func: 3: Read Holding Registers N
25 £.818181 Modbus RTU 8 Query: Unit: 2, Func: 3: Read Holding Registers
26 6.826162 Modbus RTU 17 Response: Unit: 2, Func: 3: Read Holding Registers
29 7.001237 Modbus RTU 8 Query: Unit: 2, Func: 3: Read Holding Registers
38 7.917284 Modbus RTU 17 Response: Unit: 2, Func: 3: Read Holding Registers
33 7.993283 Modbus RTU 8 Query: Unit: 2, Func: 3: Read Holding Registers
34 8.0083868 Modbus RTU 17 Response: Unit: 2, Func: 3: Read Holding Registers
37 9.815383 Modbus RTU 8 Query: Unit: 2, Func: 3: Read Holding Registers
38 5.831635 Modbus RTU 17 Response: Unit: 2, Func: 3: Read Holding Registers
41 10.022764 Modbus RTU 8 Query: Unit: 2, Func: 3: Read Holding Registers
42 10.0838361 Modbus RTU 17 Response: Unit: 2, Func: 3: Read Holding Registers
45 18.998217 Modbus RTU 8 Query: Unit: 2, Func: 3: Read Holding Registers
46 11.029425 Modbus RTU 17 Response: Unit: 2. Func: 3: Read Holding Reegisters
5> Frame 29: 8 bytes on wire (64 bits), 8 bytes captured (64 bits)| 0808 @3 88 69 08 86 15 e7 s I1
DLT: 147, Payload: mbrtu (Modbus RTU)
~ Medbus RTU
[unit 1D: 2
CRC-16: ©x15e7 [unverified]
[CRC-16 Status: Unverified]
> Modbus

|
I
L © UnitID (mbriuunit_id), 1 byte

Packets: 68 - Displayed: 34 (50.0%) - Dropped: 0 (0.0%)

These can then be saved to a new capture file which only includes these frames.

Similar filters can be applied to other message fields to isolate only the frames of interest. This makes capture
file sharing and analysis much more manageable.

Summary

Modbus RTU communication issues can be difficult to isolate without visibility of the network traffic. However, with a
capture of network traffic, troubleshooting often proceeds very quickly. Wireshark is a free network packet analyzer
that is very powerful. Once installed and setup, capturing the traffic on a Modbus RTU network can be accomplished
easily, and has shown to be a very valuable tool. This technical note summarizes the installation and setup of Wireshark
for Modbus RTU packet traffic.
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